
Power Stroke User Guide



   Po

2 

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Copyright
Power Stroke is based on research and technology by Liron Yatziv and 

Guillermo Sapiro from the Department of Electrical and Computer Engineering, 

University of Minnesota, and is exclusively licensed by Digital Film Tools.

No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of Digital Film Tools.

Copyright © Digital Film Tools, LLC. 2015. All Rights Reserved

January 17, 2015

About Us
Digital Film Tools brings together the unbeatable combination of superior 

software designers, motion picture visual effects veterans, video editors and 

photographers. Add three Emmy Awards and experience in creating visual 

effects for hundreds of feature films, commercials and television shows and you 

have a recipe for success. The understanding of photography, film and video 

editing, and in particular visual effects, allows us to design productive and 

highly specialized software. Software that is useful as well as easy to use. Our 

products stand up to the rigors of production and are the culmination of many 

years of experience.

Our philosophy is to bring our visual effects tools and techniques to the 

masses. What was once found only in expensive high-end packages or existed 

as proprietary in-house tools, is now available to photographers, artists, 

designers, and video/film editors. Did I mention affordable? Our software 

doesn't cost an arm and a leg and won't break the bank.
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 POWER STROKE

Introduction
Designed with the creative workflow of colorists, film/video editors, graphic 

designers and artists in mind, Power Stroke introduces a simple, interactive 

stroke-based workflow to quickly and intuitively perform targeted adjustments.

Instead of meticulously drawing exact masks, using inaccurate matte 

extractions or hand painting frame to frame, regions of interest are isolated by 

drawing a few simple and loose After Effects open or closed masks. Power 

Stroke then uses the concepts of luminance-weighted chrominance blending 

and fast intrinsic distance computations to determine the edges of your target 

area and adjustments are made only in those areas. Masks can be assigned 

multiple corrections and effects such as color correction, recoloring or 

desaturation, colorization of black and white images, blur, fill light for dimly lit 

image areas and Diffusion/Glow. 

Using patented algorithms, Power Stroke produces high-quality results at a 

fraction of the complexity and computational cost of previous techniques. At 

long last, gestural selection, colorization and image adjustment have been 

combined into one natural, fast and easy process.
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 INSTALLATION

1 Download Power Stroke at www.digitalfilmtools.com

2 Double-click on the file that was downloaded and run through the installation 
process.

3 When prompted, select the version of After Effects to install in.

4 Apply Power Stroke to a clip in the timeline from the Effects > Digital Film Tools 
menu.

A dialog box pops up when you run Power Stroke.

5 If you purchased the software, select Activate Power Stroke and follow the 
instructions.

or 

6 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of Power Stroke for the specified trial period. At the end 
of the trial period, Power Stroke reverts to a limited demo mode.

or

7 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, a watermark is superimposed over the image.
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 UNINSTALLING

Windows
From the Windows Start Menu, select Programs > Digital Film Tools > Power 

Stroke v1.0 > Uninstall Power Stroke.

Macintosh
Go to Applications/Digital Film Tools/Power Stroke v1.0 and double-click on 

Uninstall Power Stroke.
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 ACTIVATING, DEACTIVATING AND 
TRANSFERRING LICENSES

Activation Options

Internet Activate
Activates Power Stroke over the Internet.

Request License from Self-Service Website
If you do not have an Internet Connection on the computer where you want to 

run Power Stroke, use this option. The self-service website will generate a 

license file which you can then transfer to the desired computer.

Install a License File
Loads a license file obtained from the self-service website or received by email.

Note: If you experience an error when using Internet Activate, it is because you or your 
company uses a proxy server to access the Internet and/or your firewall is blocking our 
program’s access to the Internet. For proxy server users, select Advanced Options and 
enter the appropriate proxy server settings. For firewall users, open your firewall 
software and allow our software to access the Internet.

Deactivation Options
Once Power Stroke has been activated, you can access the deactivation option 

by selecting the License button at the bottom of the Effect controls.

Internet Deactivate
Deactivates Power Stroke over the Internet and is only available if you initially 

activated over the Internet. Use this method to return your Product Code back 

to the activation server. You will then be able to use your Product Code to 

activate Power Stroke on another computer.

To deactivate Power Stroke:

1 Apply Power Stroke and click on License at the bottom of the Effect Controls 
window.

2 Choose Internet Deactivate and click Next.
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License Transfer
Your Product Code allows you to run Power Stroke on one computer at a time. 

However, you may transfer the license by deactivating on one computer and 

activating on another.

Internet Deactivate / Internet Activate is the preferred method of license 

transfer between computers, but is only available if you initially activated over 

the Internet and currently have Internet access. If you do not have Internet 

access, you will need to contact customer support to assist you in transferring 

the license.

To transfer a license:

1 Apply Power Stroke and click on License at the bottom of the Effect Controls 
window.

2 Choose Internet Deactivate and click Next.

Power Stroke is now deactivated.

3 On the target computer, select Activate Power Stroke and follow the instructions.

Power Stroke will then activate on the new computer.
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 TUTORIALS

The tutorials are designed to be completed in the order in which they are 

presented. They build on one another and later tutorials don’t necessarily cover 

features explained earlier. In addition, basic knowledge of the After Effects 

masking system is assumed. Please refer to After Effects help for more 

information on creating and using masks if you need to brush up in this area.

Selective Recoloring
Areas of the image can be easily isolated and recolored. In this tutorial, you will 

change the eye and lip color.

1 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

2 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

3 Start After Effects and double-click inside of the Project window.

4 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/stills folder, select recolor.jpg and click Open.

Before After
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5 Create a Composition by clicking, dragging and dropping the recolor.jpg image 
on the Create a new Composition icon at the bottom of the Project window.

6 If you have a slower machine, you may want to set the Resolution/Down Sample 
Factor Popup at the bottom of the Composition window to something other than Full, 
for instance Half.

Let’s start by creating some masks to use for recoloring.

7 Select the Pen tool.

8 Create an open mask and define the area to be colorized by left-clicking around 
the inside of the lip area. Do not close the mask.
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The mask should be near the boundary of the lips, but not right up against the 

edge. If the object that you wish to recolor has varying hues or brightness, the 

masks should cover these variations.

9 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

10 In the Effect Controls, open the Colorize group and select Mask 1 in the Mask 1 
pop-up menu.

11 Click the Color Picker to the right of Color 1. 

12 When the Color Picker opens, choose a magenta color. I chose Red-255, Green-
126 and Blue-186.
wer Stroke User Guide
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The color is applied to the entire image since only one mask has been drawn 

and assigned.

You can isolate the lip color to the area of the lips by using another unassigned 

mask as a barrier.

13 Select the Pen tool and create another open mask by left-clicking around the 
outside of the lips.

The color is now constrained only in the lip area. 

14 Choose the Selection tool and move around some of the points on the masks. 
Moving the points of the outer mask closer to the lips will push the lip color 
inward while moving points on the inner mask determines the location of the lip 
color.

15 Click once on the image to deselect all mask points.

Now, it’s time to change the eye color.

16 Click on the Pen tool to select it.

When drawing masks on small objects, you may find it useful to zoom into the 

image.
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17 Draw loose, open masks inside of both the left and right iris’s like the ones 
shown below. To quickly create the second open mask while using the Pen tool, 
first Ctrl(Win)/Cmd(Mac)-click once on the image in the Composition window and 
then proceed to left-click to create the second mask.

To recolor the eyes, we will use the Power Stroke Palettes.

18 In the After Effects Window pull down menu, select Power Stroke Palettes.
wer Stroke User Guide
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19 From the panel pull-down menu, select Eyes. To access the panel menu, click the 
right arrow icon at the top right of the palette.

To utilize these color palettes, you will use one of the Eyedroppers from the 

Colorize group to choose a color.

20 In the Colorize group, select Mask 3 from the Mask 2 pop-up menu.

After Effects names masks in numerical order. For instance, Mask 1, Mask 2, 

Mask 3, etc. We are choosing Mask 3 instead of Mask 2 because Mask 2 is 

acting as barrier around the lips and will remain unassigned.

21 Click the Eyedropper icon to the right of Color 2 and click on the far right blue 
color in the Power Stroke Eye Palette.
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The blue color is assigned only to one of the eyes because Power Stroke 

doesn’t know about the other eye mask.

Since only one mask can be selected in the Mask pop-up menus, you need to 

link the two eye masks together by either the Mask Name or Mask Color. Masks 

that are linked together are considered as one mask and inherit the same 

adjustments. The name and color of the masks can be changed in the Timeline. 

Linking masks by name is the default setting, but for this example, you will link 

by the mask color. Be aware that the color of the masks need to be exactly the 

same.

22 In the Timeline, click the right arrow next to the recolor.jpg layer name and then 
the Masks heading to expand them.

23 Click on the Mask 3 name to select it and Shift-click Mask 4 to add it to the 
selection.

24 Click on the Color Picker to the left of Mask 3.

25 When the Color Picker opens, select a red color and press OK.

You will also need to change the color of Mask 1 which is for the lip recoloring.

26 Click on the Color Picker to the left of Mask 1 and set it to a blue color.

27 At the bottom of the Effect Controls window, open the Options group and select 
Mask Color from the Link Masks pop-up.

Power Stroke does not process automatically after the mask name or color is 

changed. You will need to press the Force Update button in the Effect Controls 

for Power Stroke to process the change.
wer Stroke User Guide
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28 Press the Force Update button at the top of the Effect Controls.

The blue color spills out into surrounding areas, so you will need to isolate the 

blue colorization to the area of the iris’s using a couple of unassigned masks as 

barriers.

29 Draw a loose, closed mask outside of the iris of one of the eyes. To close the 
mask, click on the first point that you created.

Once the mask is closed, the area outside the mask turns black because the 

Mask Mode is set to Add. If the Mask Mode is set to None, you will be able to 

see the entire image. There are a number of ways to change the Mask Mode, 

but we will use the Timeline method.

30 In the Timeline, the Mask heading should already be expanded from when you 
changed the color of the mask.
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31 To the right of Mask 5, change Add to None.

The entire image is now visible and it is easier to see that the blue is confined 

to the iris. It’s OK to use closed masks but they require a few extra steps to use 

them than open masks. You can get similar results to a closed mask with an 

open mask by just making sure that the ends of the open mask are close 

together.
wer Stroke User Guide
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32 Next, draw another closed mask around the outside of the other eye and set it’s 
Mask Mode to None as well.

33 If there is any color still bleeding beyond the eyes into the surrounding areas, 
choose the Selection tool and move the points of the outer eye mask closer to 
the eye.

Your final masks should something like the image below.
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34 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.

35 If you would like to load up the final After Effects project for this tutorial, you can 
open recolor.aep from the powerstroke-ae-tutorial/projects folder.
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Colorization
Colorization is the art of adding color to a monochrome image or movie. In this 

tutorial, you will colorize a black and white image.

1 You may skip steps 2 and 3 if you have already completed the previous exercise.

2 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

3 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

4 Start After Effects and double-click inside of the Project window.

5 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/stills folder, select colorize.jpg and click Open.

Before After
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6 Create a Composition by clicking, dragging and dropping the colorize.jpg image 
on the Create a new Composition icon at the bottom of the Project window.

7 If you have a slower machine, you may want to set the Resolution/Down Sample 
Factor Popup at the bottom of the Composition window to something other than Full, 
for instance Half.

Let’s start by creating some masks to use for colorization.

8 Select the Pen tool.

9 Create an open mask and define the area to be colorized by left-clicking around 
the inside of the lip area. Do not close the mask.
wer Stroke User Guide
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The mask should be near the boundary of the lips, but not right up against the 

edge. If the object that you wish to colorize has varying hues or brightness, the 

mask should cover these variations.

To select the lip color, you will pick one from the Power Stroke Palettes.

10 In the After Effects Window pull down menu, select Power Stroke Palettes.
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11 From the panel pull-down menu, select Lips. To access the panel menu, click the 
right arrow icon at the top right of the palette.

To utilize these color palettes, you will use one of the Eyedroppers from the 

Colorize group to choose a color.

12 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

13 In the Effect Controls, open the Colorize group and select Mask 1 in the Mask 1 
pop-up menu.

14 Click the Eyedropper icon to the right of Color 1 and click on the color shown 
below in the Power Stroke Lips Palette.

or
wer Stroke User Guide
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15 Click the Color Picker to the right of Color 1 and when the Color Picker opens, 
create the following color: Red-236, Green-132 and Blue-129.

The color is applied to the entire image since only one mask has been drawn 

and assigned. As you draw new masks and assign them colors, they are 

blended together based on their distances from each other as well as according 

to luminance values in the image.

Now, it’s time to add the skin color.

16 Select the Pen tool and create a new a mask starting at the top of the forehead 
and ending at the top of the lip.
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17 Add additional masks as needed around the mouth to limit the area of the lip 
color. See the image below for mask placement. Since the Pen tool is already 
active and you haven’t closed the previous mask, new masks are created by first 
Ctrl(Win)/Cmd(Mac)-clicking once on the image in the Composition window and 
then left-clicking to create the new mask.

18 Choose the Selection tool and move around the mask points so that the lip color 
is confined to the boundary of the lips. 

As you draw new masks, color is being removed from the image. This is 

because the masks have not been assigned a color. When you have 

unassigned masks, you are telling Power Stroke to leave the image in it’s 

original condition in those areas. 

Before a skin tone is assigned, you will want to link these masks together 

because only one mask can be selected in the mask selectors at a time. Masks 

of a similar name (the default link setting) or color will all be considered as the 

same mask as far as Power Stroke is concerned. For instance, if you have 
wer Stroke User Guide
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selected a mask named Mask 1 using one of the Mask selectors, masks named 

Mask 1a, Mask 1b, Mask 1c, etc. will also contribute to the colorization. The 

masks must share a common prefix for this setting to work.

19 In the Timeline, click the right arrow next to the colorize.jpg layer name and then 
the Masks heading to expand them.

20 Click on the Mask 2 name to select it.

21 Hit the Enter key, rename the mask to Skin 1 and press Enter once more.

22 Rename Masks 3-6, Skin 1a, 1b and 1c and 1d.

23 While you are at it, rename Mask 1 to Lips.

The skin masks are now linked, so assign a skin tone.

24 Back in the Effect Controls, go to the Colorize group and select Skin 1 in the 
Mask 2 pop-up menu.

25 You can select a color from the Power Stroke Skintone palette or...

26 Click the Color Picker to the right of Color 2. When the Color Picker opens, 
choose a skin tone color. I chose Red-238, Green-188 and Blue-154.

Skin tone is applied to all of the linked skin tone masks.
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As your masks start to add up, you will start to see the performance decrease. 

For faster editing, if you need to adjust the masks after they have been created 

and assigned in Power Stroke, you can either: 

• Disable the Power Stroke effect while adjusting the masks. To disable an effect, 
press the Effect switch (the “f” icon) at the top left of the Effect Controls window. 

• If Power Stroke is enabled, set the Resolution/Down Sample Factor Popup at the 
bottom of the Composition window to something other than Full.

• In Preferences > Previews, set “Adaptive Resolution Limit” to 1/8 and “Accelerate 
Effects Using” to Adaptive Resolution. This will allow Power Stroke parameter 
editing to be snappier.

Colorization of the eyes is next.

27 When drawing masks on small objects, you may find it useful to zoom into the 
image.

28 Select the Pen tool and draw loose open masks inside of both the left and right 
iris’s.

29 In the Timeline, rename Mask 1 and Mask 2 to Eye 1 and Eye 1a.

30 In the Effect Controls, go to the Colorize group and select Eye 1 in the Mask 3 
pop-up menu.
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31 You can select a brown eye color from the Power Stroke Eyes palette or click the 
Color Picker to the right of Color 3. When the Color Picker opens, choose a 
brown color. I chose Red-115, Green-46 and Blue-41.

The Brown color is applied to both eyes, but spills into surrounding areas. Use 

unassigned masks in the areas of the eye that don’t need color.
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32 Draw masks in the white areas of both eyes to remove any color coming from the 
iris. Use the image below as a reference.

Note: While in the Pen tool, you can temporarily switch to the Selection tool by using 
the Ctrl(Win)/Cmd(Mac) key to move a mask point. When you release the 
Ctrl(Win)/Cmd(Mac) key, you are back in the Pen tool.

You may be saying to yourself, self, why is the mask red? The mask is red 

because I could not see the default yellow colored mask very well, so I changed 

it’s color. You can change the color of your masks as well.

33 In the Timeline, click on Mask 1 to select it and Shift-click Mask 2 to add it to the 
selection. 

34 Click on the Color Picker to the left of Mask 1.

35 When the Color Picker opens, select a red color and press OK.

In looking at the white areas of the eyes, they don’t look quite right being 

completely white. A bit of color will help these areas.

36 From the After Effects Edit pull-down menu, choose Deselect All.

37 Back in the Timeline, rename Mask 1 and Mask 2 to White 1 and White 1a to link 
them together.

38 In the Effect Controls, go to the Colorize group and select White 1 in the Mask 4 
pop-up menu.
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39 Click the Color 4 Eyedropper and select the brown color from the Color 3 Color 
Picker.

This selects the same brown color used for the eyes.

40 Set Opacity 4 to 50%.

Having a bit of color in the white of the eyes is much more natural.

Now, the next step will be adding eye makeup.
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41 To add the eye makeup, select the Pen tool and draw masks across the eyelids 
and along the bottom edge of both eyes. You are drawing a total of four masks.

42 Rename these 4 new masks from Mask 1, 2, 3 and 4 to Makeup 1, Makeup 1a, 
Makeup 1b and Makeup 1c.

43 In the Colorize group and select Makeup 1 in the Mask 5 pop-up menu.

44 Click the Color Picker to the right of Color 5 and when the Color Picker opens, 
choose this color: Red-227, Green-156 and Blue-145.
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It’s getting there but additional skin tone masks are needed to contain the 

spreading of the eye makeup.

45 Draw additional masks below the eyes and on the forehead to contain the 
spreading of the eye makeup. See the image below Step 46 for mask placement.

46 Rename these three new masks to Skin 1e, Skin 1f and Skin 1g.

Power Stroke does not process automatically after the mask name or color is changed. 

You will need to press the Force Update button in the Effect Controls for Power Stroke 

to process the change.

47 Press the Force Update button at the top of the Effect Controls.

You are in the final stretch. Finish up by colorizing the eyebrows and hair.

48 Draw masks on both eyebrows.

49 Name the new masks Eyebrow 1 and Eyebrow 1a.

50 Back in the Effect Controls, go to the Colorize group and select Eyebrow 1 in the 
Mask 6 pop-up menu.

51 Choose a reddish brown color from the Power Stroke Hair Palette or select the 
following color from the Color 6 Color Picker: Red-122, Green-75 and Blue-64.
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52 Add two masks to the hair on either side of the face.

53 Name the new masks Hair 1 and Hair 1a.

54 In the Colorize group and select Hair 1 in the Mask 7 pop-up menu.

55 Click the Color Picker to the right of Color 7 and when the Color Picker opens, 
choose this color: Red-133, Green-109 and Blue-89.

That’s it. You are done.Your final masks should something like the image below.
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56 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.

57 If you would like to load up the final After Effects project for this tutorial, you can 
open colorize.aep from the powerstroke-ae-tutorial/projects folder.
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Color Adjustment
Using the Adjust tab, you can color correct and adjust the color of the image in 

the area defined by a mask. Hue, saturation, brightness, contrast, gamma, red, 

green, blue, temperature and cyan/magenta can all be adjusted and 

manipulated.

1 You may skip steps 2 and 3 if you have already completed the previous exercise.

2 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

3 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

4 Start After Effects and double-click inside of the Project window.

5 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/hiker folder, select hiker.0001.jpg and click Open.

6 Double-click on the hiker.[0001-0015].jpg sequence in the Project window and 
click the Play icon in the Time Controls to see what the clip looks like.

7 When you are done playing the clip, hit the Spacebar to stop playback and close 
the Footage window.

Before After
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8 Create a Composition by clicking, dragging and dropping the hiker.[0001-
0015].jpg sequence on the Create a new Composition icon at the bottom of the 
Project window.

The goal of this exercise is to change the color of the hiker’s hat and nothing 

else. Let’s start by creating some masks.

9 Select the Pen tool.

10 Create an open mask and define the area to be colorized by left-clicking around 
the inside of the green area of the hiker’s hat. Do not close the mask.
Power Stroke User Guide    
• 
• 
•
•
•



   Po

36 Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

The mask should be near the boundary of the hat, but not right up against the 

edge. If the object that you wish to colorize has varying hues or brightness, the 

mask should cover these variations.

11 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

12 In the Effect Controls, open the Adjust 1 group and select Mask 1 in the Mask 
pop-up menu.

13 Set the Cyan/Magenta adjustment to a value of 25.
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The Cyan/Magenta color correction is applied to the entire image since only 

one mask has been drawn and assigned.

You can isolate the color correction to the area of the hat by using a new, 

unassigned mask as a barrier.
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14 Select the Pen tool and create a new, open mask by left-clicking around the 
outside of the of the hiker’s head.

The color correction is now isolated to the hat area. 

15 If any of the color correction is bleeding beyond the edges of the hat, choose the 
Selection tool and move around the mask points.

Now that you have some masks, animate them over time so that they follow the 

motion of the hiker. To animate masks over time, you need to turn on the Time-

vary Stop Watch icon for the Mask Shape parameter in the Timeline.

16 In the Timeline, click the right arrow to the left of the hiker.[0001-0015].jpg layer 
name to expand it.

17 Click the right arrow next to the Masks heading to expand it to reveal the masks 
on that layer.

18 Click the right arrow next to the Mask 1 name to expand it.
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19 Press the Time-vary Stop Watch icon next to Mask Shape to activate keyframing.

20 Repeat the previous two steps for Mask 2.

Before you proceed to animate the masks over time, you may find it helpful to 

disable Power Stroke while doing so. To disable an effect, press the Effect 

switch (the “f” icon) at the top left of the Effect Controls window. 

21 Temporarily disable Power Stroke by pressing the Effect switch (the “f” icon) at 
the top left of the Effect Controls window.

22 Make sure the Selection tool is active and go to different frames in the Timeline 
and adjust the masks as necessary.

The shape of the masks will now change over time.

23 Play through the Composition to make sure that the masks are properly 
following the hiker.

24 Once you are happy with your mask animation, position the Timeline at frame 1.

25 Enable Power Stroke by pressing the Effect switch (the “f” icon) at the top left of 
the Effect Controls window.

26 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.
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27 Select Composition > Preview > RAM Preview to check your results so far.

28 If you would like to load up the final After Effects project for this tutorial, you can 
open hiker.aep from the powerstroke-ae-tutorial/projects folder.
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Selective Black and White
Selective black and white effects have become increasingly popular and can be 

achieved using Power Stroke, even if you are working with objects that contain 

fine detail, like strands of hair.

1 You may skip steps 2 and 3 if you have already completed the previous exercise.

2 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

3 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

4 Start After Effects and double-click inside of the Project window.

5 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/stills folder, choose selective_bw.jpg and click Open.

Before After
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6 Create a Composition by clicking, dragging and dropping the selective_bw.jpg 
image on the Create a new Composition icon at the bottom of the Project 
window.

7 If you have a slower machine, you may want to set the Resolution/Down Sample 
Factor Popup at the bottom of the Composition window to something other than Full, 
for instance Half.

The first step is to draw some masks that will be used to create a selective black 

and white color effect.

8 Select the Pen tool.

9 Create an open mask by left-clicking around the inside edge of the boy, being 
careful to get as close to the edge as possible without crossing over it.

As you draw the mask, you may find that it’s default yellow color is hard to see. 

If you’d like, you can change the color to red, for instance, as you are drawing.
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10 In the Timeline, click the right arrow next to the selective_bw.jpg layer name and 
then the Masks heading to expand them.

11 Click on the color box to the left of the mask named Mask 1.

12 When the Color Picker opens, select a red color and press OK.

13 Continue drawing the mask until you have completely traced around the inner 
edge of the boy.

The mask should be near the boundary of the boy, but not right up against the 

edge. If the object that you wish to colorize has varying hues or brightness, the 

mask should cover these variations.

Black and White effects are easily added by applying a gray color to a mask.

14 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

15 In the Effect Controls, open the Colorize group and select Mask 1 in the Mask 1 
pop-up menu.

16 Click the Color Picker to the right of Color 1 and when the Color Picker opens, 
choose a gray color: Red-128, Green-128 and Blue-128.
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Actually, you can pick any shade of gray to create a black and white effect.

The black and white effect is applied to the entire image since there is only one 

mask. Limit the black and white effect by creating a new, unassigned mask as 

a barrier.
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17 Select the Pen tool and create a new mask by left-clicking around the outside 
edge of the boy.

Depending on where your black and white mask is drawn, you most likely will 

see some areas in the edge of the boy that still have color. In my version, there 

still is color in the boy’s hair to the right of his face.

Instead of drawing additional masks to contribute to the black and white effect, 

you can use the Selection tool to move the mask points to a new position.

18 Choose the Selection tool.
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19 Before adjusting any points, you may find it useful to zoom into the image.

20 Select a single point or a selection of points.

21 Click and drag one of the selected points and they are all moved to the new 
location.

22 Examine the edges of the boy and repeat the previous two steps as needed.
wer Stroke User Guide



• 

Tutorials  47 

• 
• 
• 
•
•
•

Your masks should something like the image below.
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23 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.

24 If you would like to load up the final After Effects project for this tutorial, you can 
open selective_bw.aep from the powerstroke-ae-tutorial/projects folder.
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Blur
Individual masks and the areas defined by them can have varying blur values 

to create interesting depth of field effects.

1 You may skip steps 2 and 3 if you have already completed the previous exercise.

2 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

3 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

4 Start After Effects and double-click inside of the Project window.

5 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/stills folder, select blur.jpg and click Open.

Before After
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6 Create a Composition by clicking, dragging and dropping the blur.jpg image on 
the Create a new Composition icon at the bottom of the Project window.

7 If you have a slower machine, you may want to set the Resolution/Down Sample 
Factor Popup at the bottom of the Composition window to something other than Full, 
for instance Half.

The first step is to create masks and assign varying levels of blur to them to 

create a depth of field effect.

To keep the Power Stroke processing as fast as possible, the Blur, Fill Light and 

Diffusion/Glow controls are global settings which are applied in varying 

amounts to each mask using the Effects control in the Adjust groups. As as 

result, applying effects is a two step process: Adjust the Effects parameter to 

something other than 0 and then apply the desired effects. In this case, a Blur 

is being applied to create a depth of field effect.
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8 Select the Pen tool.

9 Create an open mask by left-clicking across the top band of clouds.

10 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

11 In the Effect Controls, open the Adjust 1 group and select Mask1 in the Mask pop-
up menu.

12 Set the Effects parameter to a value of 100.

Nothing happens yet, because the blur amount hasn’t been adjusted.
Power Stroke User Guide    
• 
• 
•
•
•



   Po

52 Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

13 Open the Blur group and adjust the Amount to 10.

We have achieved blur, although it is applied to the entire image since there is 

only one mask. Protect the bottom foreground clouds by using a new, 

unassigned mask as a barrier.

While using the blur effect and as your masks start to add up, you will start to 

see the performance decrease. For faster mask editing after they have been 

created and assigned in Power Stroke, you can either: 

• Disable the Power Stroke effect while adjusting the masks. To disable an effect, 
press the Effect switch (the “f” icon) at the top left of the Effect Controls window. 

• If Power Stroke is enabled, set the Resolution/Down Sample Factor Popup at the 
bottom of the Composition window to something other than Full.

• In Preferences > Previews, set “Adaptive Resolution Limit” to 1/8 and “Accelerate 
Effects Using” to Adaptive Resolution. This will allow Power Stroke parameter 
editing to be snappier.

14 Temporarily disable Power Stroke by pressing the Effect switch (the “f” icon) at 
the top left of the Effect Controls window.
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15 Select the Pen tool and create a new mask by left-clicking along the edge of the 
bottom set of clouds. See the image below Step 15 for mask placement.

Note: If it any time you would like to adjust the position of points on a mask, choose the 
Selection tool and move around the mask points. Just remember to switch back to the 
Pen tool when you want to draw a mask. 

16 Enable Power Stroke by pressing the Effect switch (the “f” icon) at the top left of 
the Effect Controls window.

This new, unassigned mask limits the area of blur. To achieve a depth of field 

effect, additional masks with varying Effect amounts, and thus varying blur 

levels, can be created. To help keep track of your masks, rename the new 

barrier mask.

17 In the Timeline, click the right arrow next to the blur.jpg layer name and then the 
Masks heading to expand them.

18 Click on the Mask 2 mask name to select it.

19 Hit the Enter key, rename the mask to Barrier and press Enter again.

Additional masks will now be added to create the depth of field effect.
Power Stroke User Guide    
• 
• 
•
•
•



   Po

54 Tutorials

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

20 Disable Power Stroke by pressing the Effect switch (the “f” icon) at the top left 
of the Effect Controls window.

21 Create three more open masks across the various bands of clouds. See image 
below for mask placement. When the Pen tool is already active and you haven’t 
closed a previous mask, you can quickly create a new open mask by first 
Ctrl(Win)/Cmd(Mac)-clicking once on the image in the Composition window and 
then proceed to left-click to create the new mask.

The areas around the new masks remain unaffected until you add the blur 

effect to them as well.

22 Enable Power Stroke by pressing the Effect switch (the “f” icon) at the top left of 
the Effect Controls window.

23 Open the Adjust 2 group In the Effect Controls, select Mask 2 in the Mask pop-
up menu and set the Effects parameter to a value of 80.

Mask 2 now has blur applied to it, but since the Effects control is set to 80, less 

blur is applied than Mask 1.

Note: Since the effect parameters are global, if you turned up the values in Fill Light or 
Diffusion/Glow, they would also be applied to the mask in addition to the blur.

24 Open the Adjust 3 group, select Mask 3 in the Mask pop-up menu and set the 
Effects parameter to a value of 60.

Mask 2

Mask 3

Mask 4

Mask 1

Barrier
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25 Open the Adjust 4 group, select Mask 4 in the Mask pop-up menu and set the 
Effects parameter to a value of 40.

Varying amounts of blur are now applied to each mask. Your masks and 

adjustments should something like the image below.
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26 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.

27 If you would like to load up the final After Effects project for this tutorial, you can 
open blur.aep from the powerstroke-ae-tutorial/projects folder.
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Fill Light
Fill Light adds light to shadow areas as if you were adding light at the time of 

photography.

1 You may skip steps 2 and 3 if you have already completed the previous exercise.

2 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

3 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

4 Start After Effects and double-click inside of the Project window.

5 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/stills folder, select fill.jpg and click Open.

Before After
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6 Create a Composition by clicking, dragging and dropping the fill.jpg image on 
the Create a new Composition icon at the bottom of the Project window.

7 If you have a slower machine, you may want to set the Resolution/Down Sample 
Factor Popup at the bottom of the Composition window to something other than Full, 
for instance Half.

The first step is to create a mask to assign fill light to.

To keep the Power Stroke processing as fast as possible, the Blur, Fill Light and 

Diffusion/Glow controls are global settings which are applied in varying 

amounts to each mask using the Effects control in the Adjust groups. As a 

result, applying effects is a two step process: Adjust the Effects parameter to 

something other than 0 and then apply the desired effects. In this case, a Fill 

Light effect will be applied.

8 Select the Pen tool.
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9 Create an open mask by left-clicking in the shadow areas of the man’s face as 
shown below.

10 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

11 In the Effect Controls, open the Adjust 1 group and select Mask1 in the Mask pop-
up menu.

12 Set the Effects parameter to a value of 100.

Nothing happens yet, because the Fill Light controls haven’t been adjusted.
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13 Open the Fill Light group and set the Brightness to 50.

Fill Light is applied to the entire image since there is only one mask. Protect the 

brighter side of the man’s face by using a new, unassigned mask as a barrier.
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14 Select the Pen tool and create a new mask by left-clicking on the brighter side of 
the man’s face like the mask shown below.

The barrier mask limits the Fill Light to the darker side of the man’s face.

Note: If it any time you would like to adjust the position of points on a mask, choose the 
Selection tool and move around the mask points. Just remember to switch back to the 
Pen tool when you want to draw a mask. 
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15 Create another open mask on the far right side of the screen. When the Pen tool 
is already active and you haven’t closed a previous mask, you can quickly create 
a new open mask by first Ctrl(Win)/Cmd(Mac)-clicking once on the image in the 
Composition window and then proceed to left-click to create the new mask. See 
image below for mask placement.

The Fill Light is localized only to the darker side of the man’s face.
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16 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.

17 If you would like to load up the final After Effects project for this tutorial, you can 
open fill.aep from the powerstroke-ae-tutorial/projects folder.
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Diffusion/Glow
Diffusion/Glow creates diffusion or glows around selected areas of the image.

1 You may skip steps 2 and 3 if you have already completed the previous exercise.

2 Go to www.digitalfilmtools.com and download the tutorial images from the 
download tab.

3 Double-click on the powerstroke-ae-tutorial.zip file that you downloaded to 
uncompress it.

4 Start After Effects and double-click inside of the Project window.

5 When the Import File window opens, navigate to the powerstroke-ae-
tutorial/footage/stills folder, select glow.jpg and click Open.

Before After
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6 Create a Composition by clicking, dragging and dropping the glow.jpg image on 
the Create a new Composition icon at the bottom of the Project window.

7 If you have a slower machine, you may want to set the Resolution/Down Sample 
Factor Popup at the bottom of the Composition window to something other than Full, 
for instance Half.

The first step is to create a mask and assign a glow to it.

To keep the Power Stroke processing as fast as possible, the Blur, Fill Light and 

Diffusion/Glow controls are global settings which are applied in varying 

amounts to each mask using the Effects control in the Adjust groups. As a 

result, applying effects is a two step process: Adjust the Effects parameter to 

something other than 0 and then apply the desired effects. In this case, a Glow 

effect will be applied.

8 Select the Pen tool.
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9 Create an open mask by left-clicking in the center of the woman’s face.

10 From the Effect pull-down menu, select Power Stroke from the Digital Film Tools 
group.

11 In the Effect Controls, open the Adjust 1 group and select Mask 1 in the Mask 
pop-up menu.

12 Set the Effects parameter to a value of 100.

Nothing happens yet, because the Diffusion/Glow controls haven’t been 

adjusted.
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13 Open the Diffusion/Glow group and set the Amount to 120 and the Blur to 30.

Diffusion/Glow is applied to the entire image since there is only one mask. You 

can now use a new, unassigned mask as a barrier to limit where the 

Diffusion/Glow affects the image.
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14 Select the Pen tool and create a new mask by left-clicking around the outside of 
the face like the mask shown below.

Note: If it any time you would like to adjust the position of points on a mask, choose the 
Selection tool and move around the mask points. Just remember to switch back to the 
Pen tool when you want to draw a mask. 

The unassigned, barrier mask limits the Diffusion/Glow to the woman’s face, 

but it would look a lot better if we could add a little warmth to the Diffusion/Glow.

15 Click on the Eyedropper to the right of the Diffusion/Glow > Color parameter and 
pick a warm skin tone off of the image.

To finish off this shot, it would be good to also darken the face area defined by 

the mask.

16 In the Adjust 1 group, set the Brightness parameter to a value of -8.

Adjust and Colorization settings can be combined with effects.
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17 To better see your result, turn off the display of the masks by clicking in the gray 
area immediately outside of the image in the Composition window.

18 If you would like to load up the final After Effects project for this tutorial, you can 
open glow.aep from the powerstroke-ae-tutorial/projects folder.
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 POWER STROKE USER GUIDE

Description
Designed with the creative workflow of colorists, film/video editors, graphic 

designers and artists in mind, Power Stroke introduces a simple, interactive 

stroke-based workflow to quickly and intuitively perform targeted adjustments.

Instead of meticulously drawing exact masks, using inaccurate matte 

extractions or hand painting frame to frame, regions of interest are isolated by 

drawing a few simple and loose After Effects open or closed masks. Power 

Stroke then uses the concepts of luminance-weighted chrominance blending 

and fast intrinsic distance computations to determine the edges of your target 

area and adjustments are made only in those areas. Masks can be assigned 

multiple corrections and effects such as color correction, recoloring or 

desaturation, colorization of black and white images, blur, fill light for dimly lit 

image areas and Diffusion/Glow. 

Using patented algorithms, Power Stroke produces high-quality results at a 

fraction of the complexity and computational cost of previous techniques. At 

long last, gestural selection, colorization and image adjustment have been 

combined into one natural, fast and easy process.
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After Effects Masks
Power Stroke uses loose After Effects open or closed masks to determine the 

edges of your target area and color correction, colorization or effects 

adjustments are made only in those areas.

Creating Masks
Power Stroke can use either open or closed masks. If you choose to use closed 

masks, set the Mask Mode to None. This way, the image area outside of the 

mask will remain visible instead of black.

To create masks in After Effects:

1 Select the Pen tool and left-click to add mask points to the image in the 
Composition window.

2 To close a mask, click on the first point that you selected.

3 The easiest way to create multiple open masks in After Effects while the Pen tool 
is selected is to Ctrl(Win)/Cmd(Mac)-click on the image in the Composition 
window. The next time you left-click, a new mask is created.

Animating Masks
To animate masks so that they move over time, you need to turn on the Time-

vary Stop Watch icon for the Mask Shape parameter in the Timeline.

To animate a mask in After Effects:

1 Click the right arrow to the left of the layer’s name to expand it.

2 Click the right arrow next to the Masks heading to expand it, revealing all masks 
on that layer.

3 Click the right arrow next to the mask name to expand it.

4 Press the Time-vary Stop Watch icon next to Mask Shape to activate keyframing.

5 Go to different frames in the Timeline and adjust the mask.

The shape of the mask will now change over time.
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Linking Masks
If you want to assign more than one mask the same adjustment, you can link 

masks by either similar names or colors. Go to the Link Masks section on 

page 83 for more information.

Note: Refer to After Effects help for more information on creating and using masks.

Parameters
The Power Stroke parameters are organized according to function in the After 

Effects Effect Controls.

Force Update
Forces Power Stroke to process. Power Stroke does not process automatically 

after the mask color or name is changed. If Link Masks > Mask Color or Mask 

Name is selected prior to the mask color or name being changed, you will need 

to use Force Update to process the change.
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Adjust 1-10
The Adjust 1-10 groups manipulate the color of the image in the area defined 

by masks. Hue, saturation, brightness, contrast, gamma, red, green, blue, 

temperature and cyan/magenta can all be adjusted and manipulated. Up to ten 

different color corrections can be applied. However, the same color corrections 

can take place in different areas of the image by linking masks of similar name 

or color. Go to the Link Masks section on page 83 for more information.

Note: Adjust controls can be used in conjunction with the Colorize adjustments by 
selecting the same mask in both the Adjust and Colorize groups.

Adjust Workflow
• Draw a mask on an area of the image.

• Open the Adjust 1 group and select the mask that you just created in the Mask 
pop-up menu.

• Make an adjustment using one of the Adjust parameters.

The adjustment is applied to the mask and since this is the only mask that has 

been drawn and assigned, the adjustment is applied to the entire image.

• Draw another mask on a different area of the image.

The area around the new mask remains unaffected until you make a new 

adjustment.

• Open the Adjust 2 group and select the mask that you just created in the Mask 
pop-up menu.
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• Adjust a parameter in the Adjust 2 tab.

The different mask adjustments are blended together based on their distances 

from each other as well as according to luminance values in the image.

• Additional masks can be linked to those selected in the Adjust 1 and Adjust 2 
groups by using a common color or name. Go to the Link Masks section on 
page 83 for more information.

Mask
Select the After Effects mask to be used for the color correction or effects 

adjustment.

Hue
Rotates the hue of the image in the area defined by a mask.

Saturation
Adjusts the saturation of the image in the area defined by a mask. Positive 

values saturate, negative values desaturate.

Brightness
Adjusts the brightness of the image in the area defined by a mask. Positive 

values brighten, negative values darken.

Contrast
Adjusts the contrast of the image in the area defined by a mask. Positive values 

increase contrast, negative values decrease contrast.

Gamma 
Adjusts the gamma of the image in the area defined by a mask. The gamma 

adjustment leaves the white and black points the same and only modifies the 

values in-between. Positive values darken the midtones, negative values 

lighten the midtones.

Red
Adds or subtracts red from the image in the area defined by a mask.

Green
Adds or subtracts green from the image in the area defined by a mask.
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Blue
Adds or subtracts blue from the image in the area defined by a mask.

Temperature
Sets the color of the image, in the area defined by a mask, to be either warmer 

or cooler. Dragging the parameter to the right makes the image cooler (bluer) 

and dragging the parameter to the left makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image in the area defined by a mask. 

Dragging the parameter to the right makes the image more magenta and 

dragging the parameter to the left makes the image more cyan.

Effects
Sets the amount of each effect (Blur, Fill Light, Diffusion/glow) applied to the 

selected mask.
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Colorize
Colorization is the art of adding color to a monochrome image or movie. The 

idea of coloring photos and films is not new. Ironically, hand coloring of 

photographs is as old as photography itself. There exists such examples from 

1842 and possibly earlier. Colorization was used in motion pictures in the early 

1900’s by the French Company Pathé, where many films were colored by hand. 

It was also a common practice for filmstrips into the 1930’s. The computer-

assisted process was first introduced by Canadians Wilson Markle and Brian 

Hunt in 1970 for adding color to black and white movies.

The Colorize parameters allow you to perform colorization of black and white 

images, as well as recoloring or desaturation. Up to 20 different colorizations 

can be applied. However, the same colorizations can take place in different 

areas of the image by linking masks of similar name or color. Go to the Link 

Masks section on page 83 for more information.

Note: Colorize adjustments can be used in conjunction with the Adjust controls by 
selecting the same mask in both the Colorize and Adjust groups.

Colorize Workflow
• Draw a mask on an area of the image.

• Open the Colorize group and select the mask that you just created in the Mask 1 
pop-up menu.

• Click on the Color 1 Color Picker, and when it opens, choose a color and click OK.

Before After
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• Adjust Opacity 1 if desired.

The color is applied to the mask and since this is the only mask that has been 

drawn and assigned, the adjustment is applied to the entire image.

• Draw another mask on a different area of the image.

The area around the new mask remains unaffected until you make a new 

adjustment.

• Select the new mask from the Mask 2 pop-up menu.

• Click on the Color 2 Color Picker, and when it opens, choose a color and click OK.

• Adjust Opacity 2 if desired.

The different mask adjustments are blended together based on their distances 

from each other as well as according to luminance values in the image.

• Additional masks can be linked to those selected in the Mask 1 and Mask 2 pop-
up menus by using a common color or name. Go to the Link Masks section on 
page 83 for more information.

Mask 1-20
Select the After Effects mask to be used for the colorization.

Color 1-20
Color changes the currently assigned mask. Clicking the Color Picker box 

opens a standard Color Picker.

No Colorization
A mask not assigned in any of the mask selectors will retain the image’s original 

colors in the area of that mask. Also, when white is selected as the Current 

Color (the default) of an assigned mask, no colorization takes place in the area 

of that mask.

Black and White
If you select any variation of gray as the current color, all assigned masks will 

make the image black and white in the area of that mask.
Power Stroke User Guide    
• 
• 
•
•
•



   Po

78 Power Stroke User Guide

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Eyedropper
Selecting the Eyedropper icon and then clicking anywhere on the screen will 

select that color as the Current Color.

Opacity 1-20
Adjusts the opacity of the current color. You will only see the effect of the opacity 

control once a mask is applied to the image.

Palettes
When colorizing, the Power Stroke Palettes are helpful in selecting colors from 

a number of useful, pre-made color palettes.

Accessible from the After Effects Window pull-down menu, Power Stroke 

Palettes consist of the following choices: Astronomical, Beach, Cloth, Drinks, 

Earthtones, Eyes, Flowers, Foliage, Four Seasons, Fruits, Hair, Ice Cream, 
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Landscapes, Lips, Metal, Painterly, Skintone, Stone, Subdued, Sweets and 

Vegetables. To utilize these color palettes, you will use one of the Eyedroppers 

from the Colorize group to choose a color from the palette.

To view and use the color palette:

• In the After Effects Window pull down menu, select Power Stroke Palettes.

• Use one of the eyedroppers in the Colorize tab to pick a color from the Power 
Stroke Palette.

• Switch palettes using the panel menu. To access the panel menu, click the right 
arrow icon at the top right of the palette.
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Effects
Three different effect types can be applied to a mask: Blur, Fill Light and 

Diffusion/Glow.

Effects Workflow
To keep the Power Stroke processing as fast as possible, the Blur, Fill Light and 

Diffusion/Glow controls are global settings which are applied in varying 

amounts to each mask using the Effects parameter in the Adjust groups. As a 

result, applying effects is a two step process: Adjust the Effects parameter in 

the appropriate Adjust group to something other than 0 and then apply the 

desired effect: Blur, Fill Light or Diffusion/Glow.

• Draw a mask on an area of the image.

• Open the Adjust 1 group and select the mask that you just created in the Mask 
pop-up menu.

• Set the Effects parameter to 100.

Nothing happens yet because Power Stroke is waiting for you to make an 

adjustment to one of the Effects.

• Adjust the Blur > Amount, Fill Light > Brightness or Diffusion/Glow > Amount 
separately or in combination with each other.

The adjustment is applied to the mask and since this is the only mask that has 

been drawn and assigned, the adjustment is applied to the entire image.

• Draw another mask on a different area of the image.

• Open the Adjust 2 group and select the mask that you just created in the Mask 
pop-up menu.

• Set the Effects parameter to 50.

Since the effects settings are global, this new mask now has the same effect 

parameters applied to it as the first one, but only at half of the strength. When 

different Effect values are used per mask, the effects are applied at various 

strengths.

The different mask adjustments are blended together based on their distances 

from each other as well as according to luminance values in the image.

• Additional masks can be linked to those selected in the Adjust 1 and Adjust 2 
groups by using a common color or name. Go to the Link Masks section on 
page 83 for more information.
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Blur
Individual masks and the areas defined by them can have varying blur values 

to create interesting depth of field effects.

Blur
Blurs the image in the area defined by a mask.

Fill Light
Fill Light adds light to shadow areas as if you were adding light at the time of 

photography.

Before After
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Brightness
Sets the intensity of the fill light.

Position
Selects the shadow values that will be adjusted with the Brightness parameter.

Range
Controls the range of shadow values that will be adjusted with the Brightness 

parameter. A higher Range value includes more values in the shadows while a 

lower Range value includes less values.

Diffusion/Glow
Diffusion/Glow creates diffusion or glows around selected areas of the image.

Amount
Sets the amount of the diffusion/glow.

Blur
Sets the softness of the diffusion/glow.

Color
The Color parameter sets the color of the diffusion/glow through the use of a 

standard Color Picker or Eyedropper. The default color is white.

Before After
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Blend
Determines the blend mode to be used to create the diffusion/glow effect.

Add
The diffusion/glow is added to your image.

Normal
The diffusion is mixed with the original image. In this mode, the Amount 

parameter only shows changes up to a value of 100.

Screen
The diffusion/glow is combined with the image using a Screen blend mode. 

This looks kind of like the Add blend mode, but highlights are retained.

Position
When using the Add and Screen blend modes, Position selects the values used 

to create the diffusion/glow effect. A higher Position value uses the brightest 

image values to create the diffusion/glow. A lower Position value uses the 

darkest image values to create the glow.

Range
When using the Add and Screen blend modes, Range controls the range of 

values to be used for the diffusion/glow. Once you’ve selected the Position, you 

can then add or subtract the Range of values to be used in the diffusion/glow 

source. A higher Range value includes more values in the diffusion/glow source 

while a lower Range value includes less values.

Options

Link Masks
Power Stroke utilizes mask selectors where only one mask can be selected at 

a time. If you want to use more than one mask for the colorization, color 

correction or effect, you will need to link the masks by either Mask Color or 

Mask Name. 
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Mask Color
Masks of the same color will all be considered as the same mask as far as 

Power Stroke is concerned. For instance, if you have selected a green colored 

mask using one of the mask selectors, all green masks will contribute to the 

desired colorization, color correction or effect. However, the color of the masks 

need to be exactly the same for this setting to work.

To change the color of a mask in the Timeline:

Mask are colored yellow by default. If you plan on linking masks together by 

their color, you will need to change the color of the masks.

1 In the Timeline, click the right arrow next to the layer name and then the Masks 
heading to expand them.

2 Click on the Color Picker to the left of the mask name.

3 When the Color Picker opens, select a color and click OK.

Note: Power Stroke does not process automatically after the mask color is changed. If 
Link Masks > Mask Color is selected prior to the mask color being changed, you will 
need to press the Force Update button in the Effect Controls for Power Stroke to 
process the change.

Mask Name
Masks of a similar name will all be considered as the same mask as far as 

Power Stroke is concerned. This is the default setting. For instance, if you have 

selected a Mask named Mask 1 using one of the mask selectors, masks named 

Mask 1a, Mask 1b, Mask 1c, etc. will also contribute to the desired colorization, 

color correction or effect. The masks must share a common prefix for this 

setting to work.

To rename a mask in the Timeline:

By default, masks are named Mask 1, Mask 2, Mask 3, etc. If you plan on 

linking masks together by their name, you will need to change their names.

1 In the Timeline, click the right arrow next to the layer name and then the Masks 
heading to expand them.

2 Click on the mask name to select it.
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3 Hit the Enter key, rename the mask and press Enter once again.

Note: Power Stroke does not process automatically after the mask name is changed. 
If Link Masks > Mask Name is selected prior to the mask name being changed, you will 
need to press the Force Update button in the Effect Controls for Power Stroke to 
process the change.

Power Stroke After Effects Tips and Tricks
There are a number of tips and tricks to streamline and enhance the 

performance of Power Stroke in After Effects.

• If you need to adjust the masks after they have been created and assigned in 
Power Stroke, you can either: 

•1) Disable the Power Stroke effect while adjusting the masks. To disable an 
effect, press the Effect switch (the “f” icon) at the top left of the Effect 
Controls window. 

•2) If Power Stroke is enabled, set the Resolution/Down Sample Factor Popup at 
the bottom of the Composition window to something other than Full.

•3) In Preferences > Previews, set “Adaptive Resolution Limit” to 1/8 and 
“Accelerate Effects Using” to Adaptive Resolution. This will allow Power 
Stroke parameter editing to be snappier.
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